
   
 
 

Copyright 2008, GoKnow! Inc.    Last Updated:     Page 1 
All rights reserved.     10/07/08 

 
 
 

Mobile Learning Environment and 
MyProjects User Guide   
Version 2.1 for Nova5000 

 
 
Table of Contents 
 
What is MLE? What is MyProjects? ................................................................................ 2�
System Requirements ..................................................................................................... 2�
Getting Started – Logging In ........................................................................................... 2�
Creating a New Project ................................................................................................... 3�
Opening a Saved Project & Deleting a Project ................................................................ 4�
Saving a Project under Another Name ............................................................................ 5�
Exiting MyProjects .......................................................................................................... 5�
Resources ....................................................................................................................... 5�
Using resources .............................................................................................................. 6�
Moving To and From Project View .................................................................................. 6�
Moving, Renaming and Deleting resources on the Canvas ............................................. 7�

���������	
���	

���������������������������������� ����������������������������������������������� �
�
����������	�	
���	

����������������������������� ��������������������������������������������� �
�
�
�������	
���	

�������������������������������� ����������������������������������������������� �

Brief Overview of Each Resource.................................................................................... 9�
��������������������������������������������������� ������������������������������������������������� �
��
�
���������������������������������������������� �������������������������������������������������� �
�
 ����
	������������������������������������������� ���������������������������������������������!" �
�������
	������������������������������������������ �����������������������������������������������!� �
#��
	�
��$ ���	
	����������������������������������� ���������������������������������������������%" �
�����&�'������������������������������������������� ������������������������������������������������%! �
��	�	���(����
�����	������������������������������� ����������������������������������������������%( �
)�������������������������������������������������� �����������������������������������������������%� �
#����	��������������������������������������������� ������������������������������������������������%� �
��
�
�*�+,����������������������������������������� ����������������������������������������������%� �
�
+�������
	��������������������������������������� ����������������������������������������������(" �
�	
�
����������
	���������������������������������� ��������������������������������������������(� �
-����
��������������������������������������������� �����������������������������������������������(( �

Additional Features ....................................................................................................... 45�
.�����'�
�+�������

������������������������������� ����������������������������������������������(� �
�
��������'���
	����/
	���������������������������� ������������������������������������������(� �

Additional Support ......................................................................................................... 45�



   
 
 

Copyright 2008, GoKnow! Inc.    Last Updated:     Page 2 
All rights reserved.     10/07/08 

 
 
 

What is MLE? What is MyProjects?  
As the name implies, the Mobile Learning Environment  (MLE) is an educational environment 
consisting of students, teachers, mobile devices, and curriculum.  The Mobile Learning 
Environment is designed to accomplish two educational goals: Engage the students (have fun), 
and keep them Organized (stay focused).  Students working on a project in the MLE use 
MyProjects on their mobile devices to access their project home page. 
 
MyProjects enables students to organize multiple resources on one simple screen and 
encourages students to use a variety of different learning tools— concept maps, animations, 
tables, paragraphs, slideshows and web resources—to build complex, multiform projects.  
 
MyProjects combines GoKnow!’s animation and concept mapping software with Fourier 
Nova5000’s academic and productivity bundled software. MyProjects includes: TextMaker, 
PlanMaker, Internet Explorer, Sketchy, PiCoMap, MultiLab, Portrait4 Calculator, NovaPaint, 
Inspiration, PocketXpdf, Media Player, and Presentations. Top it all off with GoSync and 
GoManage for distributing, viewing, and grading projects, and you have a powerful learning tool. 
 

System Requirements  
�  Nova5000 1.00.08 or later with Windows CE 5.0 or later 
�  1 MB memory  
�  Active Ethernet connection or WiFi 802.11 (for GoSync usage) 
�  We recommend 20 MB RAM and at least 6 MB storage space 

 
Getting Started – Logging In  

Each student has their own unique MyProjects username and password. These are created the 
first time they open MyProjects on their Nova.  
 
��� �  NOTE: If you are using MyProjects with GoManage in your classroom, be sure to use the 
same username in MyProjects and GoManage.  
 
To start MyProjects, tap the Start  menu �  Programs  �  GoKnow! MyProjects . 

1. If this is the first time MyProjects is being used on the Nova: 
a. Enter a username you would like to use (for instance, your first and last name 

together -- e.g. AbeLincoln) 
b. Tap “Log In” (Figure 1, next page) 
c. MyProjects asks you to enter a password. This is the password you will use to 

log into MyProjects from now on 
d. Create your password, type it in and tap “OK” 
e. MyProjects asks you to re-enter your password 
f. Re-enter your password, then tap “OK.” This launches MyProjects. 
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Figure 1  

 

2. If this is NOT the first time MyProjects is being used on the Nova: 
a. Select your username from the combo box (Figure 1, above) 
b. Type in your password and tap “OK” 
c. This launches MyProjects 

 

��� �  NOTE: If you do not see your user name in this box, you need to create a new one. Tap 
<New User>, type your username in (for instance, your first and last name together -- e.g. 
AbeLincoln), tap “Log In,” create a password, tap “OK,” re-enter the password. Tap “OK.” 
 

Creating a New Project  
Once you have logged in with your username and password, you will see a Recent Projects 
screen that lists the most recent projects you have worked on (Figure 2). If you have never 
created a project, there will be nothing listed here! 
 

 
Figure 2  
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To create a new project, tap “New Project.” A box appears asking you to name your project. 
Give your project a name and tap “Create.” Welcome to the main MyProjects screen (Figure 3). 
 

 
Figure 3  

 

The large yellow area on the left side of the screen is the canvas. The area on the right side of 
your screen is the Resource bar, which contains a list of applications.  
 

Opening a Saved Project & Deleting a Project  
If you have already created a project, you can open it when you first log in to MyProjects. Select 
the project you wish to open from the list, and tap “Open” (Figure 2, previous page). 
 

��� �  NOTE: If your project is not listed on the recent projects screen, tap “Browse.” This lists all 
the projects you have available. Tap the one you would like to open, then tap “Open.” 
 

To delete a project when you first log in to MyProjects, tap “Delete” from the bottom of the 
recent project screen. When you tap “Delete,” you will bring up a list of projects on your device 
(Figure 4). Tap on the project you wish to delete, and tap “Delete.” You will be asked if you are 
sure you want to delete this project. Tap “Yes.” 
 

 
Figure 4 
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If you are currently working on a project, and wish to delete the active project, tap “Delete” from 
the file menu. A window appears, asking you if you really want to delete this project. Tap “Yes.” 
You will return to the Recent Projects screen. 

 
WARNING! Deleting a project also deletes all the files that are associated with it. For example, 
if you have a Sketchy resource on your MyProjects canvas, and you delete the project, you will 
be deleting the project file and the Sketchy file! If the project hasn’t been synchronized using 
GoSync, the file can’t be recovered.  Be careful with this. 
 

Saving a Project under Another Name  
1. To save a project under another name, open that project, then tap “Save Project As” 

from the file menu. 
 
2. Type a new name for the project, then tap “Save.” 

 
Exiting MyProjects  

1. If you have just logged into MyProjects, tap “Exit” from the Recent Projects screen. 
 

2. If you are currently working on a project, tap “Exit” from the file menu. Your work is 
automatically saved. 

 
Resources  

Once you have created a new project or opened an existing project, you will see your canvas 
and resource bar. The resource bar features all of the programs and tools that MyProjects 
offers.  To see all of the resources, use the arrows to navigate through the list.  
 
These Resources are:  

  TextMaker 

  PlanMaker 

  Internet Explorer 

   
Sketchy 

 PiCoMap  

 MultiLab 

   Portrait4 Calculator
 

  NovaPaint 
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  Inspiration 

  PocketXpdf 

  Media Player 

  Presentations 

 
GoSync 

 
Available disk space 

  
Remaining battery power 

 
Using resources  

To use any of the resources, simply tap on the icon in the resource bar. You will be prompted to 
name your resource. Enter a name and tap “Create” (Figure 5).  
 

 
Figure 5 

 
��� �  NOTE: If you leave the box next to “Open resource after create” checked, the resource will 
open automatically once you tap “Create.” If you uncheck the box, a tile with the name of the 
resource will be placed in MyProjects, but the actual resource will not open until you tap on it 
from the MyProjects canvas. 
 

Moving To and From Project View  
The ease of moving to and from the MyProjects canvas is one of the things that makes it so 
powerful. It takes just one tap to work on your resource and one or two taps to get back to your 
canvas:  

1. To return to MyProjects after you have finished working on your resource, simply tap the 

 button in the upper-right hand corner.  
 
2. Your work is saved automatically in Sketchy and PiCoMap.  

 

3. In TextMaker, PlanMaker, and NovaPaint, when you tap the  button to return to 
MyProjects, you will be prompted to save the changes you made to the document. Tap 
“Yes” to save the changes. 
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��� �  NOTE:  In MultiLab and Inspiration, tapping  without saving may result in lost data. 
Instead, tap the file menu, then “Save” to be sure that MyProjects will catch any changes made 

before tapping  to close and return to the canvas. 
 
To access a resource from your project canvas, simply tap on it. 
 

Moving, Renaming and Deleting resources on the Canv as 
Moving a resource  
You may move a resource anywhere on the canvas once it has been created. To move your 
resource, touch your stylus within the resource’s box, then drag the stylus to the desired 
location. The resource will move with your stylus movement. Lift your stylus off the screen to 
place the resource. 
 
Renaming your resource  
To rename your resource, tap and hold down the text of the resource you wish to edit. A drop-
down menu appears (Figure 6). Tap “Rename.” You will be prompted to enter a new name for 
your resource. When you are done, tap “Rename.” If you are using a mouse, you can right click 
on the resource to edit it. 

 

 
Figure 6 

Deleting a resource  
��� �  Warning:  Deleting a resource also deletes the file that is associated with it. For example, if 
you have a Sketchy resource on your canvas, and you delete the resource, you will also be 
deleting the Sketchy file itself. If your project hasn’t been synchronized using GoSync, the file 
can’t be recovered. Be careful, please! 

 
To delete a resource, tap and hold on the name of resource to bring up the context menu 
(Figure 6, above). Tap “Delete”. Tap “Delete” again at the warning prompt. 
 

Importing a Resource  
Whenever you create a resource in a project, you will notice an option that says “Import” next to 
the “Create” button in the “New Resource” window (Figure 7). This allows you to import existing 
resources into your project. If you already have the perfect file on your Nova that you want to 
include in MyProjects, importing is the way to go. 
 

 
Figure 7  
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To import a resource: 
 

1. In order to import a resource, you must first create the same type of resource as the one 
you wish to import. For example, if you wish to import a PiCoMap, you must first create a 
PiCoMap in MyProjects, then tap “Import” in the “New Resource” window. 

 
2. When you tap “Import,” you will see a list of all the resources of that type that have been 

created. For example, if you created a PiCoMap resource and tapped “Import,” you 
would see a list of all of the PiCoMaps currently on the device. These PiCoMaps would 
be grouped by project. 
 

3. Select the resource you wish to import and tap “Import” (Figure 8). 
 

 
Figure 8  

 
 

��� �  NOTE:  MyProjects defaults to automatically opening the new resource. To place the 
resource on the canvas without immediately going to it, un-check the checkbox next to “Open 
resource after create” prior to tapping Import in step 2. 
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Brief Overview of Each Resource  

PiCoMap   
PiCoMap is a tool that enables students to create concept maps. 
 

Creating a PiCoMap resource 
 

To create a PiCoMap resource, tap from the resource bar. Give the resource a name, then 
tap “Create”. You arrive at a new PiCoMap canvas. 
 
There are two main elements that are used when creating concept maps – concepts and links. 
A concept is an idea that is contained in a single shape. A link is a line connecting two concepts. 
To create a new concept, use the stylus to draw an oval on the PiCoMap canvas (Figure 9) – it 
doesn’t have to be a perfect shape! This shape is often referred to as a “node.” 
 

 
Figure 9 

 
When you release your stylus, you will be taken to a “Create Concept” window (Figure 10).  

 

 
Figure 10 

 
Enter the name of your concept in the box next to “Name.” You can change the color of your 
node by tapping the arrow next to the color in the “Color” box and tapping on the desired color.  
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If you wish to add notes to your concept, you can type in the “Notes” box. This can be useful if 
you want to add supporting details. For example, if your main concept was the name of an 
important leader, you could include dates of rule, birthday, or other important information in the 
notes section. 
 
��� �  Note: Notes will not show up on the main concept map. However, the node will be shaded in 
gray to indicate that there are notes. 
 
When you have finished creating your concept, tap “Ok” to return to the main PiCoMap canvas.  
 
Your new concept node will appear (Figure 11).  
 

 
Figure 11 

 
Repeat this process to create as many nodes as you desire. As shown in Figure 12, nodes that 
contain additional notes are shaded in gray. 
 

 
Figure 12 
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Moving resources and navigating the canvas 
 

To move your concept to a different location on the screen, simply tap inside the shape and 
drag your stylus across the screen. Release your stylus at the desired location. 
 

��� �  NOTE: The scroll bar on the right side of the screen allows you to move your nodes further 
apart as needed. 
 

Creating links 
 

Once you have created two or more concepts, you can draw links to connect them. To draw a 
link, simply use your stylus to draw a line from the middle of one concept to the middle of 
another (Figure 13).  
 

 
Figure 13 

 

A “Create Link” box will appear (Figure 14). 
 

 
Figure 14  



   
 
 

Copyright 2008, GoKnow! Inc.    Last Updated:     Page 12 
All rights reserved.     10/07/08 

 
 
 

In the box next to “Name,” you can enter text to describe the relationship between two concepts, 
or you can leave it blank. Notice that below the name box, there is text starting with “Do you 
mean” (Figure 14, previous page). This text indicates the directionality of the relationship. 
 

For example, if you created a link between the words “speed” and “acceleration,” and added the 
text “is an increase in” in the name box, the “Do you mean” section would say “Do you mean: 
speed is an increase in acceleration?” Since you probably meant to say that acceleration is an 
increase in speed, you can tap the “Reverse” button to change the directionality of the 
relationship. 
 

You can also add notes to a link, just like with a concept. For example, if you link two people 
who were married, the notes section would be a good place to add the date of their wedding. 
 

When you are finished, tap “Ok.” You will return to the main PiCoMap screen. As you can see, a 
link is drawn between the concepts with the text you entered and an arrow indicating 
directionality (Figure 15). If you entered notes, the text box would be shaded in gray. If you left 
the name box blank, you would only see the arrow, no text. 
 

 
Figure 15 
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Editing concepts and links 
 

To edit a concept simply tap on the concept to open the “Edit Concept” window (Figure 16). 
Make your changes, then tap “Ok.” 
 

 
Figure 16 

 
To edit a link, tap the link to open the “Edit Link” window. As with editing concepts, make your 
changes, then tap “Ok.” 
 

Deleting concepts and links 
To delete a link, follow the same steps you used to edit a link (tap on the link to bring up the 
“Edit Link” window). Then, instead of making changes and tapping “Ok,” simply tap “Delete” 
instead (Figure 17). 
 

 
Figure 17 
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To delete a concept, simply draw a diagonal line through it on the main PiCoMap canvas 
(Figure 18). 
 

 
Figure 18 

 
A confirmation window will pop up. Tap “Yes” to delete the concept. 
 
��� �  NOTE: If you delete a concept that is linked to another concept, you will also delete the link. 
However, if you only delete a link, the concepts will not be deleted. 
 

As with any resource, when you are finished creating your PiCoMap, tap the  in the top right 
corner of the screen to return to the main MyProjects canvas. PiCoMap saves your work 
automatically when you close it. 
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Sketchy   
Sketchy is a drawing and animation tool. Students create animations using freehand and 
geometric shapes. Animations can be 999 frames long, and helpful features such as duplicate 
frame and insert frame enable efficient and easy animation creation. Teachers use Sketchy to 
have students animate processes, relationships and concepts such as cell development and 
plant growth. 
 

Creating a Sketchy resource 
 

To create a Sketchy resource, tap  from the resource bar. Give the resource a name, 
then tap “Create”. You arrive at a new Sketchy canvas. 
 

Basic Sketchy tools 
 

When you first open Sketchy, you will see a blank canvas with a number of menus and icons 
across the top of the screen (Figure 19). These icons are the tools available in Sketchy. We’ll 
start with the File menu and go through everything from left to right. More information about 
using the tools is in the “Using the tools” section a bit later. 
 

 
Figure 19 

 

1. File 
·  If you tap on the file menu, you will have the option to return to the main 

MyProjects canvas. You can also tap on the  in the top right corner of the 
screen to return to your main canvas. 

2. Edit 
·  If you tap on the edit menu, you will see the options to undo, import image, cut, 

copy, paste, and select all. These tools are useful for copying and moving things 
from one frame to another or duplicating things on a single frame. For example, 
you could use the select tool to select a shape, then use copy and paste to paste 
that same shape in another part of the frame. The “import image” feature will be 
discussed in more detail later. 
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3. Frame 
·  Tapping on the frame menu pulls up the options to insert before, insert after, 

duplicate, clear, and delete. The insert before and insert after options allow you 
to insert a blank frame either before or after the one you are currently viewing. 
This is useful if you get to the end of an animation and realize you need an extra 
frame in the middle! The duplicate, clear, and delete options do the same as the 
icons on the right side of the icon bar. These will also be explained in more detail 
later. 

4. Drawing tools  
·  If you tap on the pencil icon, you will see a popup menu with a variety of drawing 

tools (Figure 20). 
 

 
Figure 20 

·  These tools are: 

    Pencil tool for freehand drawing 

  Eraser 

   Select tool (for selecting areas of a picture) 

  Straight line tool 

  Ribbon drawing tool 

  Text tool for inputting text 

   Filled-in square 

   Filled-in circle 

   Square outline 

  Circle outline 

   Color selector tool 
 

5. Color palate  
·  If you tap on the color palate, you will see a popup menu containing a number of 

different colors (Figure 21).  You can tap on any of these colors prior to using 
another tool to change the color of the shape/line/text/etc. You can also tap on 
“More” for more colors. 

 
Figure 21 
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6. Pen size tool  
·  If you tap on the pen size tool, you will see a popup menu with several options 

(Figure 22). You can tap on one of the lines to change the thickness of the line 
drawn using the pencil or straight line tools. This will also change the size of the 
eraser. Make your selection prior to using another tool. 

 
Figure 22 

7. Play animation  
·  The green camera icon is how you play an animation once it has been created. 

Tap on it once to play the animation – it will turn red. Tap on the red camera icon 
to stop the animation. 

8. Frame navigation  
·  The frame navigation lets you know what frame you are on. When you create a 

new frame, the number will increase. You can use the arrows to go back and 
forth between frames.  

9. New frame tool  
·  If you tap on the new frame tool, you will create a new, blank frame. You will see 

that the frame number increases and you will automatically be taken to the new 
frame. 

10. Duplicate frame tool  
·  For making animations, the duplicate frame tool is one of the most important 

tools available. If you tap on this duplicate frame icon, you will duplicate the 
frame you were on. You will see that the frame number increases by 1. After 
duplicating a frame, you could move something on the 2nd frame, duplicate that 
frame, and continue that process for several more frames. When you play the 
animation, you will see movement! 

11. Clear screen  
·  The red X icon is how you clear a screen. You must be on the frame you wish to 

clear, then tap this icon. Anything that has been drawn in that frame will be 
erased. This doesn’t delete the actual frame – it only clears the contents. 

12. Delete entire frame  
·  The small recycling bin icon is how you delete an entire frame. Navigate to the 

frame you wish to delete, then tap the recycle icon. The frame will be deleted. If 
there were frames after the one you deleted, you will be taken to the next frame 
of the series. IMPORTANT: you will not be asked to confirm that you want to 
delete a frame, so be careful! 

13. Cut  
·  When you select something using the “select” tool, you can cut it to move it to 

another location or a different frame. 
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14. Copy  
·  As with the “cut” tool, once you have selected something, you can use the “copy” 

tool to duplicate it. 

15. Paste  
·  Whenever you have cut or copied something, use the paste tool to place it in the 

new location. 

16. Undo  
·  If you tap on the undo tool, you will undo the last step of whatever you did (i.e. 

the last shape you drew). This tool will only undo ONE step, so if you make a 
mistake, you should use the undo tool right away! 

 

Using the tools 
 

To draw, simply select a tool from the Tool menu and draw on the screen! Certain tools function 
slightly differently than others, so here is some additional information: 
 

1. Using the text tool 
·  First, choose the color you want your text to be from the color menu. Then, select 

the text tool from the drawing tools. 
·  Tap on the screen to position your cursor. 
·  A popup box will appear with a space for you to enter text. 
·  Type your desired text. 
·  If you want, you can use the drop-down menu under “size” to change the size of 

the font. 
·  When you have finished typing, be sure to tap somewhere else on the screen to 

make the text permanent. 
 

��� �  NOTE: You can only type a limited number of characters in one line. If you would like to enter 
more text, simply tap in another position after you finish your first line. 
 
��� �  NOTE: Once you have entered text and tapped somewhere else on the screen, you can no 
longer edit the text. If you made a mistake, you can erase what you wrote and type it again. 
 

2. Using the select tool 

·  Choose the select tool from the drawing tools menu  
·  Use your stylus to drag a box around the region you want to select. The easiest 

way to do this is put your stylus down in the top left corner of where you want the 
selection box to begin, then drag to the bottom right corner of where you want the 
box to end. 

·  Release the stylus when you have created the box. 
·  To move the selected area, tap in the middle and drag it to a new location. 

Remember, if you don’t like where you moved it, tap “undo” before you go on to 
another step! 
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3. Using the shapes (square or circle) 
·  To create a shape, first select the desired color from the color palate on the tool 

bar. Then, select the shape from the drawing tools menu. 
·  Put your stylus down on the screen, then drag your stylus until the shape is the 

size you want. 
·  Remember – you can always undo the shape, or select and move it! 

 
Importing an image in Sketchy 

Under the “Edit” menu, there is an option that says “Import Image.” Clicking on this option will 
bring up an “Import” window. This window will list all the image files on your Nova. You can 
select one of these images to import into your Sketchy. Simply tap on the file name, then tap 
“Import.” The image will appear in the top right corner of your Sketchy. While it is still selected 
with the dotted box, you can drag the image to the desired location on the frame. 
 
If you do not have any image files on your Nova, your list in the Import window will be blank. 
You can use GoManage to send images to your Nova (see the GoManage user guide). 
 
��� �  NOTE: when saving images on your Nova or on your desktop to be sent to your Nova, you 
want to save them as a .jpg file, not a .bmp file. This helps reduce the file size so as not to take 
up unnecessary amounts of memory on your device. 
 

Creating an animation in Sketchy 
 

To create an animation in Sketchy, you must first create multiple frames (like you were creating 
a flipbook). Below is an example of a simple Sketchy illustrating one circle orbiting around 
another (Figure 23). As you can see, the frame number increases every time the smaller circle 
is moved. This was accomplished by duplicating the frame, then selecting the small circle, 
moving it slightly, duplicating the new frame, and repeating the process. 
 

 
Figure 23 
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As with any resource, when you are finished creating your Sketchy, tap the  in the top right 
corner of the screen to return to the main MyProjects canvas. Sketchy saves your work 
automatically when you close it. 
 

TextMaker   
TextMaker is a word processing tool similar to Microsoft Word®, but is created by a company 
called SoftMaker. TextMaker is an application that allows you to type, edit, and work with basic 
text formatting options. 
 

Creating a TextMaker resource 
 

To create a TextMaker resource, tap  from the resource bar. Give the resource a name, 

then tap “Create.” You arrive at a new TextMaker document.  
 

Basic TextMaker features 
 

When you first open TextMaker, you will arrive at a blank screen (Figure 24). You can start 
typing right away, or you can use some of the options to change formatting, layout, etc. 
 

 
Figure 24 

 
Across the top of the screen, you will see a number of menus and icons. Similar to Microsoft 
Word, these menus and icons allow you to format your text. You can change the font, the 
alignment of the text, and the indentations. You can also insert pictures, date and time stamps, 
etc. Some of the key features of TextMaker are listed below. 
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Formatting options 
 

Font formatting 
Drop-down menus allow you to change the font, as well as the size and the color. Simply tap on 
the arrow to the right of the item you wish to change to see the options (Figure 25). 

 

 
Figure 25 

 
In addition, you have the following options: 

    Bold  

    Italic 

     Underline 

 
Layout options 

    Align text left 

    Align text right 

    Center text 

    Justify text 

   Bulleted list 

   Numbered list 

   Shift item left 

   Shift item right 
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Spell check 
 

Tapping the spell check button  brings up a window that allows you to choose how much of 
the document you wish to check (Figure 26). The “from caret” option will begin checking spelling 
from the location of your cursor. The “whole document” option will spell check everything, 
regardless of the location of your cursor. You can also access the spell check feature under the 
“Edit” menu at the top of the screen. 
 

 
Figure 26 

 
Track changes 

 
As with Microsoft Office, you can track changes in TextMaker. To access the track changes 
feature, tap on the “Extras” menu at the top of the screen, then tap on “Changes,” and tap 
“Track Changes” (Figure 27). 

 

 
Figure 27  

 
When the “track changes” feature is turned on, an extra toolbar will appear with more options 
(Figure 28) 

 

 
Figure 28  
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Once you have turned on track changes, any additions, deletions, or comments you make to the 
original document will be displayed (Figure 29). Teachers can use this feature to comment on 
student work, and students can use the feature to annotate documents. 

 

 
Figure 29  

 
Moving and freezing toolbars 

 
Occasionally, a toolbar may accidentally be moved from its original location (Figure 30). If this 
happens, you can change the settings to move it back to its original location and prevent it from 
happening again. 
 

 
Figure 30 
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To reset toolbar location and prevent them from moving, tap on the “View” menu at the top of 
the screen. Then tap on “Toolbars” to bring up an options window (Figure 31). 
 

 
Figure 31 

 
For each toolbar, you must click on the name, then make sure the “Locked” option at the bottom 
of the window is checked. If you need to move a toolbar back to its original location, use the 

“Position” dropdown menu to select the location. When you are done, tap  to close the 
window and return to your document. 

 
Exiting TextMaker and saving your work 

 

When you have finished using TextMaker, tap the  in the top right corner of the screen. You 
will be prompted to save your work (Figure 32).  

 

 
Figure 32 

 
Tap “Yes” to save your work. 
Tap “No” if you do not want to save your work. 
Tap “Cancel” to return to the document you were working on 
 
��� �  WARNING: If you tap “No,” you will lose any changes you made to the document! 
 
��� �  NOTE: For more information on using TextMaker, consult software guides provided by 
SoftMaker. 
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PlanMaker   

 
PlanMaker is a word processing tool similar to Microsoft Excel®, but is created by a company 
called SoftMaker. PlanMaker is an application that allows you to make spreadsheets, 
manipulate data, and create graphs. 
 

Creating a Plan Maker resource 
 

To create a PlanMaker resource, tap  from the resource bar. Give the resource a name, 

then tap “Create”. You arrive at a new PlanMaker spreadsheet. 
 

Basic PlanMaker features 
 

When you first open PlanMaker, you will arrive at a blank screen (Figure 33).  
 

 
Figure 33 

 
Similar to other spreadsheet applications, you have rows and columns forming cells where you 
can enter information. Simply tap in a cell and begin typing! When you are done entering 
information in a cell, tap somewhere else to make the entry permanent. 
 

Formatting options 
 

Across the top of the PlanMaker screen, there are a number of menus and formatting options 
(Figure 34).  
 

 
Figure 34  
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��� �  NOTE: If you do not see the formatting toolbar, tap on “View” �  “Toolbars.” Make sure the 
Formatting toolbar is checked. As with TextMaker, you can move and freeze toolbars as 
desired. 
 
Font formatting 
Drop-down menus allow you to change the font, as well as the size and the color. Simply tap on 
the arrow to the right of the item you wish to change to see the options (Figure 35). 

 

 
Figure 35 

 
In addition, you have the following options: 

    Bold  

    Italic 

     Underline 

 
Layout options 

  Right align numbers, left align text 

    Align text left 

    Align text right 

    Center text 

    Justify text 

 
Cell formatting options 

    Format current cell as percentage 

    Format current cell as currency 

    Set borders of selected cells (tap on arrow on right to bring up more options) 
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Object mode 
 

Under the “File” menu at the top left corner of the screen is an arrow . Tapping on this arrow 
switches the formatting options from edit to object mode (Figure 36). 
 

 
Figure 36 

 
Insert options 

    Insert chart frame 

     Insert text frame 

     Insert picture frame 
 
Drawing options 

    Draw a straight line 

    Scribble (free-form drawing) 

    Draw a curve 

    Draw a straight connector 

    Draw an elbow connector 

    Draw a curved connector 

    Draw a rectangle 

    Draw a rounded rectangle 

    Draw an ellipse 

    Insert AutoShape (will bring up menu of shapes) 

    Group selected objects (select objects first – draw a box around objects to group) 
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    Edit object properties (select object first) 

 

To select a particular object, use the drop-down menu next to the “Edit object properties” button 
(Figure 37). This will bring up a list of objects in the document. Tap on the specific object you 
wish to edit. You can also directly tap on the specific object on the screen. 

 

 
Figure 37 

 

Making a graph 
 

TextMaker is a powerful tool for graphing data. You can make bar graphs, line graphs, pie 
graphs, and more! 
 
To make a graph, first enter your data in the spreadsheet. Select all the cells that contain the 

data you want to include in the graph. Then, click on the arrow  under the “File” menu to 

switch to object mode. Click on the insert chart frame icon . Then, draw a box for your chart. 
 
A chart properties window will appear (Figure 38). 
 

 
Figure 38 
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Under the “Chart type” tab, select the type of chart you want to create. If the data was not 
selected before you created the graph, tap on the “data source” tab and enter the cells 
containing the data in the box next to “Data source area.” 
 
Under series, make changes to what data is included and how the axes are labeled. When you 

are done, tap on . You will return to your spreadsheet and your graph will appear (Figure 
39). You can resize your graph by dragging the boxes in the corner of the graph. 
 

 
Figure 39 

 

When you have finished using PlanMaker, tap the  in the top right corner of the screen. You 
will be prompted to save your work (Figure 40).  

 

 
Figure 40 

 
Tap “Yes” to save your work. 
Tap “No” if you do not want to save your work. 
Tap “Cancel” to return to the spreadsheet you were working on 
 
��� �  WARNING: If you tap “No,” you will lose any changes you made to the document! 
 
��� �  NOTE: For more information on using PlanMaker, consult software guides provided by 
SoftMaker. 
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Internet Explorer    

 
Internet Explorer is an internet browser similar to internet browsers found on most computers. 
To use Internet Explorer on the Nova5000, you must first be connected to the internet. For 
information about connecting to the internet, talk to your network administrator or IT support 
staff. 
 

Creating an Internet Explorer resource 
 

To create an Internet Explorer resource, tap from the resource bar. Give the resource a 

name, then tap “Create.” 
 
You arrive at a screen that details how to add a web page resource to your project (Figure 41). 
 

 
Figure 41 

 
Using Internet Explorer 

 
To access a website, type in the URL address of the web page you would like to go to or select 
the web page from your Favorites. 
 
Once you have navigated to the desired website, you are able to save the link or save the page 
for offline viewing. 
 
��� �  NOTE:  If you save the link only, you will need to have an internet connection to view the 
resource again while saving for offline viewing will create a snapshot of the site on your 
Nova5000. 
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Saving websites 
 

To save a website, first navigate to that site, then tap “Save” from the menu at the top of the 
screen. A “Save to MyProjects” window will appear (Figure 42). Choose either “Save Online 
Link Only” or “Save for Offline Viewing.” Then, tap “Save.”  

 

 
Figure 42 

 
When the saving process is complete, you will see some statistics about the site.  Tap on 
“Return to MyProjects” and you will be returned to your project, with your web page saved as a 
resource. 
 
��� �  NOTE: For more information on using Internet Explorer, consult the software guides that 
came with your Nova5000 or guides published by Microsoft. 
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MulitLab    
MultiLab is a data analysis tool that uses external sensors to collect information. It can process 
and display many different types of data. 
 

Creating a MultiLab resource 
 

��� �  NOTE:  MultiLab resources cannot be created from inside MyProjects. You must first create 
something in MultiLab outside of MyProjects. To do this, exit MyProjects, then open MultiLab 
from the Start Menu (Start �  Programs �  Science & Math �  MultiLab). Collect your data using 
MultiLab, then save your work. 
 
Once you have created something in MultiLab, you can import it into MyProjects. To import a 

MultiLab resource, tap from the resource bar. Tap “Import.” A list of all MultiLab resources 
will appear (Figure 43). 
 

 
Figure 43 

 

Locate the file you’d like to use and tap “Import.” If you don’t want to import a MultiLab resource, 
tap “Cancel.” 
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MultiLab will open. You can work within MultiLab, collecting and analyzing data (Figure 44). 
 

 
Figure 44 

 

When you are done using MultiLab, tap  in the top right corner of the screen to return to your 
project. If you have made any changes within MultiLab, you will be prompted to save your 
changes (Figure 45). Tap “Yes” to save your changes, or tap “No” to return to your project 
without saving your changes. 
 

 
Figure 45 

 

��� �  NOTE: For more information on using MultiLab, consult the software guides that came with 
your Nova5000. 
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Portrait4 Calculator    
Portrait4 Calculator is a full-fledged calculator that can be added as a resource to your Project.  
 
��� �  NOTE: Calculations made using Portrait4 Calculator cannot  be saved . Be sure to record 
your calculations prior to exiting the calculator. 

 
Creating a Portrait4 resource 

 

To create a Portrait4 Calculator resource, tap from the resource bar. Give the resource a 
name, then tap “Create.” You arrive at a blank calculator screen (Figure 46). 
 

 
Figure 46 

 
The calculator can perform basic mathematic functions such as addition, subtraction, 
multiplication, and division. In addition, the Portrait4 Calculator can be used as an advanced 
graphing calculator.  
 

When you are finished using the Portrait4 Calculator, tap  in the top right corner of the 
screen. Remember – your calculations will not be saved!  
 
��� �  NOTE: For more information on using the Portrait4 Calculator, consult the software guides 
that came with your Nova5000. 
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NovaPaint   
NovaPaint is a drawing tool used to create simple images. Unlike Sketchy, you cannot create 
animations using NovaPaint. 
 

Creating a NovaPaint resource 
 

To create a NovaPaint resource, tap from the resource bar. Give the resource a name, 
then tap “Create.” You arrive at a blank NovaPaint screen (Figure 47). 
 

 
Figure 47 

 
Basic NovaPaint Tools 

 
Across the top right of the screen are basic drawing tools (Figure 48). 
 

 
Figure 48 

 
These tools are: 
 

    Color picker 

    Pencil tool 

    Straight line tool 

    Draw a rectangle outline 
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    Draw a filled-in rectangle 

    Draw a rounded rectangle outline 

    Draw a filled-in rounded rectangle 

    Draw an oval outline 

    Draw a filled-in oval 

    Paint bucket tool (fill a large area with color) 

 
You can use these tools along with the color and tool size option on the left side of the screen to 
create your drawing. 
 

To return to your project once you have completed your NovaPaint drawing, tap  in the 
upper-right hand corner.  If you have made any changes to your NovaPaint resource, you will be 
prompted to save your work (Figure 49). 
 

 
Figure 49 

 
 
Tap “Yes” to save your changes, tap “no” if you do not want to save your changes. Tap “cancel” 
to continue working in NovaPaint.  
 
��� �  NOTE: For more information on using NovaPaint, consult the software guides that came with 
your Nova5000. 
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Inspiration   
Inspiration is a concept mapping program designed for middle school and high school students.  
 

Creating an Inspiration resource 
 

To create an Inspiration resource, tap from the resource bar. Give the resource a name, 
then tap “Create.” A window will appear reminding you to save your work (Figure 50). This is 

very important – Inspiration doesn’t remind you to save your work when you exit! Tap  to 
continue to Inspiration. 
 

 
Figure 50 

 
You arrive at an Inspiration screen containing a single concept node (Figure 51). 
 

 
Figure 51 
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Basic Inspiration Tools 
 
Across the top of the screen are a number of drop-down menus (File, Edit, Diagram, and 

Options). To the right of those menus is a double-arrow icon . Tapping on this icon will bring 
up/hide the row of tools below the drop-down menus. 
 
These tools are: 

    Toggle between graphic view and outline view 

    RapidFire 

    Create new node 

    Brings up symbol properties menu 

    Link nodes 

    Add/edit note 

    Delete 

    Zoom 

    About 

 
Use the tools in Inspiration to create your concept map. When you are done, MAKE SURE TO 
SAVE YOUR WORK!  
 
To save your concept map, tap “File” �  “Save.” 
 

After saving your work, tap  in the top right corner of the screen to return to your project. 
 

WARNING: Tapping  without saving may result in data being lost or corrupted. 
 
��� �  NOTE: For more information on using Inspiration, consult the software guides provided by 
Inspiration. 
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PocketXpdf  
PocketXpdf is a PDF viewer, created for mobile devices.   
 

Creating a PocketXpdf resource 
 

��� �  NOTE: Prior to creating a PocketXpdf resource, you need to have a PDF file on your Nova. 
You can use GoManage to transfer PDFs to your Nova. For more information on using 
GoManage to transfer documents, see the GoManage user guide. 
 

To create an PocketXpdf resource, tap from the resource bar. Tap “Import.” A list of PDFs 
on your Nova will appear (Figure 52). 
 

 
Figure 52 

 
Locate the file you’d like to use and tap “Import.” If you don’t want to import a PDF, tap “Cancel.”  
 

PocketXpdf options 
 

Across the top of the screen, you will see both “File” and “View” drop-down menus. Below that, 
there are several icons that can be used to navigate and view a PDF. 
 

These icons are: 

    Previous page 

    Next page 

    Zoom in 

    Zoom out 

    Zoom to selected area (tap, then draw a box around desired section of screen) 
 

The “View” menu also contains options to allow you to navigate the PDF. In addition, under the 
“View” menu, you can rotate the PDF so that you can view it horizontally or vertically. 
 

When you are finished viewing the PDF, tap “File” �  “Quit” to return to your project. 
 
��� �  NOTE: For more information on using PocketXpdf, consult the software guides that came 
with your Nova5000 or view the guide online. 
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Media Player   
Media Player is the compact, mobile version of Windows Media Player and can play back 
movies on your Nova. 
 

Creating a Media Player resource 
 

To create a Media Player resource, tap  from the resource bar. Tap “Import.” Locate the fire 
you’d like to use and tap “Import.” 
 
Use Media Player to view the movie (Figure 53). 
 

 
Figure 53 

 

To return to your project once you have completed viewing your Media Player movie, tap  in 
the upper-right hand corner.  
 
��� �  NOTE: For more information on using Media Player, consult the software guides that came 
with your Nova5000. 
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PresentationMaker   
PresentationMaker is a presentation tool based on Microsoft PowerPoint®, but is created by a 
company called SoftMaker. PresentationMaker is an application that allows you to make slide 
show presentations.  

Creating a PresentationMaker resource 
 

To create a PresentationMaker resource, tap  from the resource bar. Give the resource a 
name, then tap “Create.” 
 
��� �  NOTE: Both PresentationMaker and PlanMaker have icons with the letters “PM” on them – 
however, they are different colors. 
 
You will arrive at a blank PresentationMaker screen (Figure 54). 
 

 
Figure 54 

 
As with other presentation software, you are able to create and format slides within 
PresentationMaker. You can also play your slideshow when completed. 
 

Formatting options 
 

Across the top of the PresentationMaker screen, there are a number of menus and formatting 
options (Figure 55).  
 

 
Figure 55 
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��� �  NOTE: If you do not see the formatting toolbar, tap on “View” �  “Toolbars.” Make sure the 
Formatting toolbar is checked. As with TextMaker, you can move and freeze toolbars as 
desired. 
 
Font formatting 
Drop-down menus allow you to change the font, as well as the size and the color. Simply tap on 
the arrow to the right of the item you wish to change to see the options (Figure 56). 

 

 
Figure 56 

 
In addition, you have the following options: 

    Bold  

    Italic 

    Underline 

    Shadow 

    Emboss 

    Increase font size 

    Decrease font size 
 
Layout options 

    Align text left 

    Align text right 

    Center text 

    Justify text 

    Shift text left 

    Shift text right 
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Object toolbar 
Below the formatting toolbar is the object toolbar (Figure 57). 
 

 
Figure 57 

 
��� �  NOTE: If you do not see the object toolbar, tap on “View” �  “Toolbars.” Make sure the Object 
toolbar is checked.  
 
The options in the object toolbar are similar to those found in PlanMaker. The only difference is 
the first two icons: 
 

    Insert text box 

    Insert table 

 

��� �  NOTE: For descriptions of the other options, see the PlanMaker section in this document. 
 

Creating a presentation 
To put together a presentation in PresentationMaker, use the tools to create a series of slides. 
To add new slides, tap “Slides” at the top of the screen, then tap “Insert New Slide.” When you 
are finished, you can view your presentation by tapping “Show” �  “Start Show.” 
 

When you have finished using PresentationMaker, tap the  in the top right corner of the 
screen. You will be prompted to save your work (Figure 58).  

 

 
Figure 58 

 
Tap “Yes” to save your work. 
Tap “No” if you do not want to save your work. 
Tap “Cancel” to return to the presentation you were working on 
 
��� �  WARNING: If you tap “No,” you will lose any changes you made to the document! 
 
��� �  NOTE: For more information on using PresentationMaker, consult software guides provided 
by SoftMaker. 
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GoSync  

GoSync, combined with GoManage, the classroom manager, is an easy and effective way to 
manage a classroom’s, or even a school’s data. It can store projects from each Nova, and can 
be used to distribute assignments, grades, or even new applications. The best part is, you can 
use GoSync directly from MyProjects. 
 
��� �  NOTE: Prior to using GoSync, you must have an active internet connection (wireless or 
wired). In addition, you must have set up your sync settings. For more information on changing 
your settings, see the GoManage user guide. 
 

Syncing with GoManage 
 

1. Tap the  icon at the bottom of the resource bar. 

 
2. A GoSync window appears (Figure 59). 

 

 
Figure 59 

 
3. Make sure you see a message saying “Network Up.” 

 
4. Tap “Sync.” 
 
5. GoSync synchronizes your data with the GoManage server. 

 

6. To return to your project, tap  in the top right corner of the GoSync window. 
 
��� �  NOTE: For more information on using GoSync and GoManage, see the GoManage user 
guide. 
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Additional Features  
 
 

Available disk space    

To check available disk space, tap  from the bottom of the resource bar. A window will 

appear telling you the amount of disk space available (Figure 60). Tap  to return to your 
project. 
 

 
Figure 60  

 

Remaining battery power    
 

To check remaining battery power, tap  from the bottom of the resource bar. A window will 

appear telling you the current batter power. (Figure 61). Tap  to return to your project. 
 

 
Figure 61 

 

 
 
 
 
 
 
 
 
 

Additional Support  
 

Additional support and user information can be found at http://www.goknow.com/Support/. 
 
If you have any questions or concerns, please contact: support@goknow.com. 


